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1. Características do software

TcpScancyr  para  túneis  é  um  programa  usado  para  calcular  seções  transversais,
superfícies e volumes baseados em pontos coletados por um laser scanner 3D.

2. Requisitos

Devido à complexidade de alguns cálculos, recomenda-se o uso de um computador
que tenha, no mínimo, um processador dual core.

Requisitos mínimos:

- Sistema Operacional: Windows XP/ Vista/ 7/ 8 em 32 ou 64 bits;

- Placa gráfica: resolução mínima de 1024x728 pixels, memória de 256 Mb e 
compatível com OpenGLTM;

- Processador: Intel Dual Core 2 GHz ou superior;

- Memória: mínimo de 2 Gb.

3. Janela Principal

Após o programa ser carregado, a Janela Principal é exibida. Pode-se verificar que a
janela é dividida em várias partes, da esquerda para a direita e do topo à parte inferior pode-se
ver: 

- Menu do programa

- Barra de Ferramentas (Toolbar)

- Árvore do Projeto (Project tree)

- Janela de Vista dos Dados

- Barra de Status
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Barra de Menu: Permite acessar todas as opções do programa.

Barra de Ferramentas: Acesso rápido às principais aplicações do programa.

Árvore do Projeto: Características da árvore do projeto mostram as várias partes que
compõem o projeto. Cada nó pode ser expandido clicando no símbolo “+”. Pode-se acessar as
ações mais comuns usando o menu de contexto para cada nó, clicando sobre ele com o botão
direito do mouse.

Janela de Vista dos Dados: Quatro janelas que permitem a visualização em planta do
alinhamento horizontal,  alinhamento vertical,  superelevações,  bases e a vista em tabela de
cada elemento selecionado.

Barra  de  Status: Situada  na  parte  inferior  da  tela,  exibe  informações  sobre  as
coordenadas onde o mouse está posicionado e o estado atual do programa.

Para criar um Novo Projeto, deve-se seguir os passos descritos abaixo:

1. Crie um Novo Projeto;

2. Associe os alinhamentos horizontal e vertical, e superelevações carregando manualmente
essas informações;

3.  Cria  uma a(s)  seção(ões)  tipo importando um arquivo  DXF  ou  um arquivo  TcpTunnel  –
também pode ser criada manualmente;

4.  Importe  a  nuvem  de  pontos  do  scanner,  após  importadas  serão  automaticamente
analisadas;
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5. Calcule as seções transversais.

A ordem dos passos 3 e 4 podem ser alternadas, as seções tipo do túnel sempre devem
ser  definidas  antes  do  cálculo  das  seções  transversais.  Todavia,  é  importante  criar  os
alinhamentos antes de importar os pontos. Caso sejam importados sem os alinhamentos, use a
opção Points > Analyse. Se não, o programa não identificará a posição dos pontos da nuvem
com os respectivos alinhamentos,  e  dessa  forma não calculará  as  seções transversais,  não
desenhará corretamente a nuvem de pontos no alinhamento.

4. Projeto

Para trabalhar com o programa é necessário elementos como alinhamentos, seções
tipo, nuvem de pontos e etc., todos serão gravados no arquivo do projeto.

As principais opções do projeto podem ser encontradas no menu File.

New: Cria um projeto novo. Uma caixa de diálogo é aberta, permitindo que o usuário
selecione os elementos principais do projeto.

Open: Abre  o  seletor  de  arquivos  para  que  o  arquivo  do  projeto  (*.PRO) seja
selecionado. Caso já exista um projeto aberto que foi modificado, será perguntado se deseja
salvá-lo.

Save:  Salva  o  projeto  atual  em  um  arquivo  de  projeto.  Essa  opção  somente  será
habilitada caso o projeto já tenha sido previamente salvo, ou seja um projeto carregado.

Save as:  Abre o seletor de arquivos para salvar o projeto em um arquivo de projeto.
Para esse ponto deve-se somente salvar o projeto usando o menu File > Save. 

Properties: Abre uma caixa de diálogo que permite alterar o nome, os alinhamentos ou
o arquivo de bases que compõem o projeto.

Import: Essa opção permite ao usuário importar os alinhamentos horizontal e vertical
de diferentes formatos de arquivos.
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A figura abaixo mostra a caixa de diálogo exibida quando um novo projeto é criado, ou
quando um projeto existente é editado:

Name: Nome do projeto que será exibido no topo das listas;

Horizontal Alignment: O alinhamento do projeto pode ser deixado vazio para que seja
criado  do  início.  O  arquivo  deve  ser  compatível  com  o  formato  MDT  (*.EJE).  Caso  o
alinhamento  esteja  um outro  formato,  deixe  esse  campo vazio  e  utilize  a  outra  opção de
importação.

Vertical Alignment: O grade projetado pode ser deixado vazio para que seja criado do
início. O arquivo deve ser compatível com o formato MDT (*.RAS). Caso o alinhamento esteja
um outro formato, deixe esse campo vazio e utilize a outra opção de importação.
Superelevations:  O  arquivo  de  superelevações  dever  ser  compatível  com  o  formato  MDT
(*.PER).

Bases: Arquivo dos pontos de controle.

Cross Sections: Arquivos de seções transversais do projeto, pode ser criado sempre e
quantos forem necessários.
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Ao clicar em  OK,  o programa carregará os arquivos correspondentes e incluí-los no
projeto.

4.1 Alinhamento Horizontal

A  aplicação  suporta  arquivos  de  alinhamento  no  formato  MDT  (*.EJE) e  também
permite que outros formatos sejam importados usando a opção File > Import.

Também é possível visualizar os dados do alinhamento na janela principal, ativando a
aba Horizontal Alignment.

A janela de edição do alinhamento é dividida em duas partes – na parte superior está
localizada a barra de ferramentas que será explicada mais a frente. A tabela exibindo os dados
a serem acessados é mostrada na parte inferior da janela.

Ao adicionar  um alinhamento, seus dados devem ser inseridos  da esquerda para a
direita. O elemento somete será inserido ou modificado após a entrada de dados no campo
Field.

Inserindo uma nova linha ou clicando em New, o elemento anterior é dividido em dois,
respeitando  os  mesmos  parâmetros  de  azimute  e  raio  para  que  o  alinhamento  não  seja
afetado.  Caso  clique  na  primeira  linha  não  será  possível  inserir  um  novo  elemento  ao
alinhamento.

Na barra de ferramentas existem dois ícones extras, o primeiro otimiza o alinhamento
juntando todos os elementos consecutivos de mesmo azimute. O próximo ícone exibe os erros
de tangência de cada ponto individualmente.

Ao clicar na aba de visualização, pode-se ver a representação gráfica do alinhamento
horizontal.

Ao mover o cursor, o programa analisará as coordenadas e mostrar a informação da 
análise na barra de status.
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4.2 Alinhamento Vertical

O programa suporta alinhamentos verticais no formato MDT (*.RAS), também permite
que alinhamentos sejam importados usando a opção File > Import.

Também é possível inserir dados do alinhamento vertical na janela principal, ativando a
aba Vertical Alignment.

Para inserir um grade, primeiro adicione a estaca (em Station) e a cota (em Heigths), o
programa automaticamente moverá o cursor nas duas colunas. Pode-se alterar os dados de
acordo com o desejado.

O  programa  verificará  se  houve  sobreposição  entre  diferentes  estacas,  caso  seja
encontrada alguma, a célula em que houver sobreposição será mostrada em vermelho.

Para adicionar mais dados, vá até a última linha e e clique em  Cursor Down, e uma
linha  adicional  será  mostrada.  Caso  não  seja  realizada  nenhuma  alteração  na  nova  linha
adicionada, a mesma será apagada automaticamente.
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Clicando na aba de visualização, pode-se ver a representação gráfica do alinhamento

vertical.
Ao mover o cursor o programa analisará as coordenadas e exibirá a cota e a inclinação

da posição correspondente ao cursor na barra de status.

As seguintes camadas são exibidas na representação:

Short Marks: Cria uma linha vertical a partir da cota mínima até a cota do grade. A
distância entre as duas marcas é configurável.

Long Marks:  Cria uma linha vertical a partir da cota mínima até a cota do grade. A
distância entre as duas marcas é configurável.

Unique Points: Cria uma linha vertical nos pontos a seguir:
- Estaca – tangente
- Estaca + tangete
- Estaca se a tangente igual a zero

Guitar: Camada que exibe a separação entre linhas e legenda.

Upper ground spot height: Representa a cota máxima da intersecção do vertical que
passa através do alinhamento e a seção transversal.

Lower ground spot height:  Representa a cota mínima da intersecção do vertical que
passa através do alinhamento e a seção transversal.

Gradient: Representação gráfica do grade.

Real  gradient: Representação  gráfica  do  grade  calculado das  seções  transversais  e
seção-tipo do túnel.
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4.3 Superelevações

O arquivo de superelevações do projeto pode ser incluído, importando um arquivo ou
inserindo os dados na aba Superelevations na janela principal.

Clicando em New ou Edit, uma caixa de diálogo surgirá, permitindo que os dados de
superelevação sejam inseridos. Ao serem aceitas, as superelevações serão gravadas na ordem
da coluna Station.

Clicando em Insert, pode-se inserir uma linha anterior à linha atual. A estaca da nova
linha deve ser um ponto entre a estaca da linha anterior e a estaca da linha atual, com as
superelevações inseridas entre as duas linhas.

Para adicionar mais dados, vá até a última linha e clique em Cursor Down, e uma nova
linha será mostrada. Caso não seja realizada nenhuma alteração na nova linha adicionada, a
mesma será apagada automaticamente.
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Clicando  na  aba  de  visualização,  pode-se  ver  a  representação  gráfica  das
superelevações.

Ao mover o cursor o programa analisará as coordenadas e exibirá as informações da
análise na barra de status.

4.4 Bases

Pode-se  incluir  coordenadas  bases  que  correspondem  as  posições  do  scanner  no
momento da coleta dos pontos.

Quando aplicado o filtro por distância ou símbolo,  ele pode ser aplicado usando o
centroide dos pontos. Caso tenha sido incluído um arquivo de bases, poderá ser aplicado o
filtro ou símbolo usando a base de cada arquivo.

As  bases  são exibidas como um cilindro com um cone no topo,  centrado em suas
coordenadas.



14

5. Pontos do Projeto

Após a criação do novo projeto será necessário incluir o arquivo contendo os pontos
coletados pelo scanner.

Para incluir os pontos, use a opção Open mostrada no seletor de arquivos. Podem ser
selecionados vários arquivos ao mesmo tempo. Usando o controle de porcentagem é possível
reduzir quantos pontos serão lidos em cada arquivo, por padrão é definido 100 para que todos
os pontos sejam lidos.

O programa pode manipular tantos arquivos quanto a memória em disco suportar. Em
torno de 50 MB são necessário para cada milhão de pontos.

Além  do  nome  do  arquivo,  a  tabela  mostrará  um  número  de  campos  ainda  não
preenchidos até a caixa de diálogo ser aceita e os pontos analisados. Para que a análise dos
pontos  seja  possível,  é  necessário  que  o  alinhamento  horizontal  tenha  sido  definido
corretamente.

Descrição da tabela:

File: Nome  do  arquivo.  Em  casos  em  que  existam  arquivos  de  diferentes  locais,
somente o final, partes distintas de cada arquivo serão mostradas.

Description: Data e hora que o arquivo foi criado.

Initial Station: Estaca mínima onde existe tomada de pontos no arquivo.

Final Station: Estaca máxima onde existe tomada de pontos no arquivo.

Length: Comprimento da nuvem de pontos.
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Nº Points: Número de pontos no arquivo.

Percentage: Porcentagem de pontos importados do arquivo original.

Em  arquivos  estatísticos,  aparecem a  estaca  inicial  e  final  para  todos  os  pontos  e
também o número total de pontos.

5.1 Formato do arquivo de pontos

O programa aceita um número de tipos de formatos para os arquivos de pontos. Se o
formato de um fabricante específico não é escolhido, o formato padrão será o seguinte:

Um arquivo de texto, com um ponto por linha, no seguinte formato:

ID
(campo opcional)

Coordenadas X, Y, Z
 (campo obrigatório)

Intensidade
(campo opcional)

Cor RGB
(campo opcional)

ID: Identificação do ponto.

Coordenadas X, Y, Z: Coordenadas dos pontos.

Intensidade: Intensidade dos pontos, pode ser um número real [0 … 1] ou um valor
inteiro, dependendo do formato do arquivo.

Cor RGB:  Três valores inteiros que correspondem aos canais vermelho, verde e azul,
com valores no intervalo [0 … 255].

Os  campos  devem  sempre  aparecer  na  mesma  ordem,  apesar  de  somente  as
coordenadas serem obrigatórias. Em casos onde os campos de cores não forem definidos, os
pontos serão associados à cor padrão definida no programa.

Os formatos que podem ser importados são:

Formato FARO: A principal vantagem desse formato é que os dados são no formato
binário,  a  importação  é  significantemente  mais  rápida.  Nesta  opção,  somente  arquivos  do
formato .FLS são suportados.

Formato  Leica  HDS  4500/6000:  Esses  arquivos  tem  extensão  .FZS.  O  formato  dos
pontos incluem dois valores inteiros, a linha e a coluna. Esses dois números são ignorados e
somente as coordenadas de cada pontos são lidas.

Formato Leica Nova MS50: Arquivos com extensão .XCF.

Formato  LAS:  Arquivos  com  extensão  .LAS  ou  .LAZ  quando  os  arquivos  estão
compactados.

Formato E57: Esses arquivos tem extensão .E57.
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5.2 Análise dos pontos

Para acelerar os cálculos,  é necessário que todos os pontos importados do scanner
sejam analisados com o respectivo alinhamento horizontal. Caso a ordem normal da criação do
projeto  tenha  sido  seguida,  os  pontos  serão  analisados  ao  sair  da  caixa  de  diálodo  da
importação dos pontos.

Em caso de alteração dos alinhamentos, ou se os pontos foram importados antes do
estabelecimentos dos alinhamento no projeto, deve-se utilizar a opção Point > Analyse para
realizar a análise dos pontos com o respectivo alinhamento horizontal.

[TcpScancyr  Advanced] Caso  marcada  a  opção  Analyse  height e  Analyse  Offset o
programa não analisará os pontos fora do intervalo definido. Essa opção é usada em alguns
casos em que o túnel possui diferentes alturas ou pontos irrelevantes.
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Se  os  pontos  não  forem  analisados,  o  programa  não  identificará  em  qual  estaca
específica os pontos se localizam, e então, não será possível calcular as seções transversais.

Uma vez que o projeto teve seus alinhamentos definidos e os pontos do levantamento
analisados, pode-se usar a árvore do projeto exibida à esquerda da janela principal para que os
pontos sejam visualizados.

Selecionando o nó que corresponde ao aquivo de pontos, será ativada a aba  View,
permitindo a visualização do arquivo selecionado. Utilizando essa vista, pode-se aplicar filtros
para cada arquivo.

Ao ativar a projeção com perspectiva, a janela abaixo surgirá para auxiliar a mover a
vista sobre o alinhamento. Se as seções foram calculadas e habilitadas (usando o controle de
layers) será fácil filtrar por seleção os pontos que distorcem o cálculo das seções transversais.

Se o alinhamento horizontal não foi definido, a janela abaixo não surgirá:

Mudar a estaca também permite se mover sobre o alinhamento.

Station: Estaca onde a câmera está posicionada. Pode-se definir uma estação específica
ou usar a barra de espaço para mover em tempo real. Ao definir um valor, pressione ENTER
para que a mudança seja aplicada.

Height: A altura da câmera em relação ao alinhamento vertical.

Turn the  camera  with  the  alignment: Caso essa  opção seja  marcada,  ao mudar  a
estaca usando os controles, a câmera se posicionará de acordo com o azimute do alinhamento.

A seguir opções indicadas quando a câmera dor posicionada na mudança da estaca:

Position over alignment: Posiciona a câmera no alinhamento com a altura indicada –
caso seja movida, a disposição da câmera será cancelada.

Position  Relative  to  the  alignment: Movimenta-se  seguindo  o  alinhamento,  mas
mantendo a distância relativa existente.
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6. Filtrando pontos

A nuvem  de  pontos  obtida  do  laser  scanner  normalmente  contém  alguns  objetos
posicionados próximos do scanner no momento da tomada da cena.  Como esses  não são
pontos pertencentes ao túnel, podem ser aplicados filtros nesses pontos marcados, e então
desconsiderá-los no cálculo das seções transversais.

Dois tipos de filtros podem ser aplicados, filtro manual ou filtro visual. Para acessar o
filtro manual, use a opção Points > Manual Filter.

Determina-se as estacas inicial e final, offset e cota usando a janela de filtro manual.

Para acessar os filtros visuais, use a opção Points > Filters, ou o ícone correspondente
na barra de ferramentas.

Ao aplicar os filtros, o símbolo verde do filtro aparecerá nos pontos. O filtro somente
será aplicado nos pontos marcados em verde.

À direita de cada barra de rolagem há um botão para inserir os valores manualmente.

O botão da tela mostra os ícones a seguir:

Restore: Elimina o filtro para todos os pontos dos arquivos visualizados.

Invert:  Para  cada ponto nos arquivos  selecionados,  as  marcas  do filtro atual  serão
invertidas.

Delete:  Marca os pontos filtrados pelos parâmetros. Os pontos marcados não serão
usados no cálculo das seções transversais.

Include: Elimina a marca nos pontos filtrados pelos parâmetros. Deve-se definir a área
de interesse dos pontos que serão filtrados. Caso deseje incluir todos os pontos, use a opção
Restore.

Marcando a opção  Manual  Station na aplicação,  o  filtro  perguntará  o intervalo de
estacas. Pode-se aplicar o filtro a uma linha de pontos da nuvem ou a um grande intervalo de
pontos sem a necessidade que os mesmos estejam visíveis.
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6.1 Filtro pela distância da seção-tipo

Para aplicar o filtro à uma distância da seção é necessário que se tenha a seção, o
alinhamento  horizontal,  o  alinhamento  vertical  e  os  pontos  analisados  com  relação  aos
alinhamentos.

Station: Intervalo de estacas em que o filtro será aplicado. Coincide com os pontos da
nuvem que está sendo visualizada.

Int/Ext: Valores para offset interior e exterior da seção-tipo.

Layers:  Abre a  caixe  de diálogo  para  selecionar  a  camada  a  ser  utilizada  no filtro.
Somente uma camada pode ser selecionada por seção.

A partir dos valores máximo e mínimo a banda envolverá o modelo. Ao girar a seção no
sentido horário, os valores negativos representam a área à esquerda ou para fora da seção,
enquanto os valores positivos representam as áreas à direita ou os pontos internos.
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6.2 Filtro XYZ

Aplica filtro na estaca, offset e cota.

Station: Intervalo de estacas do filtro.

Disp: Offset máximo e mínimo para o filtro.

Height: Diferença de cota máxima e mínima para o filtro.
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6.3 Filtro por ângulo

X/Z: Posição X/Z com círculo com relação aos alinhamentos.

Station: Intervalos de estacas do filtro.

Angle: Pode-se variar o ângulo inicial e o ângulo de tomada do filtro.

Raio: Raio da circunferência ou setor circular.
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6.4 Filtro por seleção

Esse filtro é sempre aplicável, não é necessário um alinhamento, ou os pontos estarem
analisados, somente os pontos coordenados são usados. Também pode ser usado enquanto as
seções transversais são visualizadas.

Select: Ao ativar o modo de seleção, pode-se selecionar os pontos desenhando um
retângulo sobre os pontos exibidos na tela.

O primeiro clique do mouse define um canto do desenho, enquanto o segundo clique
marcará os pontos que ficaram dentro do retângulo.
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7. Simbologia

O  programa  permite  aplicar  simbologia  aos  arquivos  de  pontos,  permitindo  a
visualização da relação entre os pontos baseados no símbolo escolhido.

Para utilizar os símbolos, use o menu Points > Symbology ou o ícone correspondente
na barra de ferramentas.

Caso não exista dados suficientes para que a simbologia seja aplicada, a  opção OK
ficará desebilitada.

Símbolos disponíveis:

Delete: Elimina  os  símbolos  dos  arquivos  selecionados.  Pontos  serão  desenhados
usando a primeira cor do intervalo selecionado.

Angle: Colore  os  pontos,  baseado  no  ângulo  formado  entre  o  vertical  e  suas
coordenadas.

Scanner Color: Aplicada a cor  real  para cada ponto.  Os arquivos de pontos devem
possuir a informação de cor, caso não tenham os pontos aparecerão com a mesma cor.

Offset: Pontos coloridos de acordo com a distância em relação ao alinhamento.

Distance  to  the  base:  Se  a  base  não  foi  definida  pelo  arquivo,  os  cálculos  serão
baseados no centroide dos pontos. A distância é medida no plano XY, a cota do ponto não é
considerada.

Heigh difference: Cor do ponto é baseada na diferença de altura entre a cota do ponto
e a cota do grade na estaca.

Distance to the template: Cor dos pontos é baseada na distância até a seção-tipo. Ao
escolher essa opção, um ícone será habilitado permitindo a seleção das camadas que serão
usadas nos cálculos.
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Intensity: A intensidade dos pontos mapeados são usados como gradiente de cor, caso
a informação seja perdida, todos os pontos são coloridos com a cor do primeiro gradiente de
cor.

Inside/Outside: Esses símbolos são similares ao anterior (Distance to template) onde
os pontos são coloridos com apenas duas cores, dependendo da posição com relação à seção-
tipo.

File: Assimila a cor de cada arquivo como parte de uma série de símbolos. Caso existam
dez arquivos e esse símbolo seja aplicado a sete deles, sete cores do intervalo selecionado
serão aplicados a todos os pontos dos arquivos selecionados.

Station: Colore os pontos baseados na estaca.

Usando o controle Range pode-se alterar as cores que serão aplicadas aos pontos. Caso
deseja  alterar  as  cores  sem  alterar  os  símbolos  aplicados,  pode-se  usar  o  controle
correspondente na janela principal da aplicação.

Ao ativar os símbolos do Distance by Distance, clique em Select e abrirá uma caixa de
diálogo para que seja escolhida a camada a ser usada.
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8. Exportar Pontos

Para exportar a nuvem de pontos, use o menu Points > Export. Surgirá uma caixa de
diálogo permitindo a escolha dos arquivos a serem exportados.

A caixa de diálogo é dividida em 3 partes:

• Files
Pode-se  selecionar  os  arquivos  a  serem  exportados  selecionando-os  da  lista.  Os

arquivos  de nuvens de pontos  visualizados são marcados por  padrão.  Também existem as
opções a seguir:

All: Marca todos os arquivos
None: Remove a marca de todos os arquivos. Caso não existam arquivos selecionados,

o ícone Accept não estará habilitado.
Selected: Marca todos os arquivos de nuvem de pontos ativos.

• Filters
 Usando a opção de filtros pode-se escolher os arquivos de serão exportados.  Caso
nenhum arquivo esteja marcado, os pontos sem filtro são marcados para serem exportados.
Caso  um ou  mais  filtros  são  marcados,  pontos  serão  exportados  caso  tiverem marcas  em
comum entre eles.
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• Options
Escolha a caixa Export Color para incluir a informação de cor para cada ponto. Pode-se

também escolher  o  intervalo  de estacas,  e  somente esses  pontos  serão selecionados para
serão exportados. 

• Output
Selecionados os arquivo e os pontos que se deseja exportar, deve-se selecionar onde

os pontos serão gravados.
Existem  dois  formatos  de  arquivos  para  exportação,  escolhendo  ASCII  (*.xyz)  cada

arquivo de origem será escrito em um arquivo de destino diferente. Ao selecionar o formato
Cyclone (*.pts) os arquivos selecionados serão escritos em um único arquivo.

9. Exportando porcentagem

Caixa de diálogo para exportar a porcentagem de pontos desejada que estão contidas 
no projeto.

10. Seções Transversais

O programa permite manipular vários arquivos de seção ao mesmo tempo. Por essa
razão,  toda  vez  que  for  selecionado  algum  comando  que  afete  as  seções  transversais,  o
programa perguntará qual arquivo de seção será usado. Dependendo dos dados necessários,
alguns campos da caixa de diálogo serão ocultados.

Usando  o  controle  Cross  Sections,  é  possível  selecionar  o  arquivo  onde  deseja-se
gravar os dados, enquanto que com a Template pode-se selecionar a seção transversal que se
deseja usar como referência, pode-se usar o arquivos da seção-tipo ou da seção transversal.
Finalmente,  o  campo  Field  permite  escolher  a  seção  transversal  inteira  ou  o  corte
correspondente ao topo ou marca de referência.
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10.1 Cálculo das seções transversais

Quando se tem estabelecidos os alinhamentos e os pontos, pode-se calcular as seções
transversais da nuvem de pontos. O algoritmo usa somente os pontos que não foram filtrados. 

O programa possui dois métodos para o cálculo das seções transversais. O primeiro
deles é acessado via menu  Cross Sections > Calculate Cross Sections e pode ser usado na
nuvem de pontos provindas do laser scanner. Deve-se usar o menu Cross Sections > Calculate
Cross Sections by Regression no caso dos pontos serem provenientes de estação total (nuvem
de pontos de baixa densidade). Os dois métodos usam os mesmos parâmetros, exceto que no
segundo o filtro não é aplicado.

Ao selecionar o cálculo de seções transversais, a caixa de diálogo a seguir é mostrada
para que seja possível a alteração de alguns parâmetros.

Initial Station: Estaca em que se deseja iniciar o cálculo das seções transversais. O valor
padrão  é o valor da menor estaca onde existam pontos.

Final Station: A última estação onde em que serão calculadas as seções transversais. O
valor padrão é a maior estaca onde existam pontos.

Interval: Indica a separação entre cada seção.

Unique  Points:  Para  criar  a  seção  no  único  alinhamento  horizontal  ou  vertical,
dependendo da marca.

Manuals: Para criar seções em estacas específicas.
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Gradient  perpendiculars:  Quando  habilitada  essa  opção,  a  seção  transversal  será
perpendicular  ao  alinhamento  vertical,  se  desabilitada  as  seções  serão  perpendiculares  ao
plano  XY,  ou  a  variação  deverá  ser  definida  na  seção  transversal  (somente  para  seções
transversais manuais).

Manual Centre: Usado para alterar a origem do algoritmo de classificação. Os valores
são relativos aos alinhamentos horizontal e vertical. 

Bandwidth: A faixa de pontos selecionada a fim de calcular as seções.

10.2 Perfil Rápido

Essa opção fornece a possibilidade de criar seções transversais a partir de seleção na
nuvem de pontos. 

A  seleção  do  plano  seccionado  é  perguntada  quando  o  menu  Quick  Profile  é
selecionado. O programa mostrará a interseção entre a nuvem de pontos e o plano com a faixa
selecionada.
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10.3 Seção transversal manualmente

Usando a opção de seção manual transversal, surgirá a caixa de diálogo, indicando a
estação e a lista de variação para cada seção transversal.

Na figura abaixo a variação é desconhecida.
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10.4 Seção transversal Aberta/Fechada

Com esse comando é possível abrir ou fechar a extensão da seção. Ao abrir a extensão
de uma seção é possível escolher como realizar o processo. Existem duas formas:

Stone Key: Apaga o lado da seção transversal que está sobre o alinhamento horizontal.

Maximum edge: Apaga o lado mais distante da seção.

10.5 Seções Transversais Paralelas

Caso seja necessário criar seções transversais que são paralelas ao projeto, use o menu
Cross Sections > Parallel Cross Sections.

Primeiro selecione o arquivo de seções (que já deve ter sido criado no projeto) e o
intervalo das estacas que deseja calcular as seções transversais  paralelas.  Usando o campo
Thickness para indicar a distância entre as seções transversais paralelas, use um valor positivo
para mover as seções para fora ou um valor negativo para movê-las para dentro.

Com o valor da marca de corte, pode-se cortar a seção em relação à cota do grade,
sempre mantendo a parte superior das seções como resultado do corte.

Finalmente, deve-se adicionar o arquivo de saída, permitindo que o programa crie as
seções transversais paralelas. O arquivo será automaticamente adicionado ao projeto.
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10.6 Juntando Seções Transversais

Existe a opção de juntar dois arquivos de seções transversais usando o menu  Cross
Sections > Join Cross Sections.

Primeiro  selecionar  o  arquivo  que  deseja  modificar  (o  mesmo  deve  pertencer  ao
projeto).  Em  seguida,  defina  a  extensão  que  será  afetada  pela  modificação.  Finalmente,
selecione as seções que serão adicionadas.

O programa juntará as seções selecionadas. Se as seções transversais caírem dentro do
intervalos  de estacas  selecionados,  os  arquivos  de seções do projeto  serão incluídos.  Para
seções na mesma estação, a antiga será substituída pela do novo arquivo de seções.

10.7 Elementos a serem representados

Opções de características que mudam a representação das seções transversais na tela. 
Essa opção está disponível se a seção tipo para a seção transversal está sendo visualizada.

Points Color: Pode-se alterar a faixa de pontos que desejar, utilizando a caixa Edit à 
direita. Para exibir ou ocultar a nuvem de pontos, deve-se usar o controle de camadas.
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Dimensions: Ative essa opção caso queira exibir as dimensões entre a seção tipo e as 
seções transversais calculadas. Selecionando a opção Section > Cross Section ou Cross Section 
> Section pode-se escolher a direção das alturas. Na primeira opção, o sentido da linha é da 
seção tipo até a seção transversal, na segunda opção a distância mínima da seção transversal 
dos pontos até a seção tipo é exibida.

Inside: Preenche nas seções transversais as áreas que estão dentro da seção tipo ou da 
seção transversal de referência.

Outside: Preenche nas seções transversais as áreas que estão para fora da seção tipo 
ou da seção transversal de referência.
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10.8 Opções das Seções Transversais

Opções para as seções transversais selecionadas.

Station: A seção transversal inicialmente exibida pode ser alterada digitando o valor da
estaca ou movendo a barra de rolagem.

Recalculate: Caso encontre uma seção transversal mal definida, pode-se clicar neste
ícone, para abrir uma caixa de diálogo que permitirá recalcular usando uma faixa de pontos
maior.

Edit: Caso  não tenha  uma nuvem de pontos  que  não  esteja  muito limpa,  a  seção
transversal será calculado com picos ou segmentos falsos. Clicando nesse botão, é possível
acessar o editor de seções transversais.

Export DXF: Acessa a caixa de diálogo para exportar uma ou mais seções transversais.

Discarded:  As  seções  transversais  que  são  marcadas  e  descartadas  não  são
consideradas no cálculo de volumes, desvio do alinhamento, exportação das seções e etc.

10.9 [TcpScancyr Advanced] Criando Alinhamento

Cria um novo alinhamento a partir dos pontos selecionados na seção transversal. Essa
opção pode ser acessada em Tools > Create alignment from Cross Sections ou pela caixa de
diálogo Cross Sections Options no botão Create Alignment.
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Station Interval: Pode-se  definir  o  intervalo  e  a seção transversal  que será  exibida
neste passo.

Horizontal Alignment: Cria o alinhamento horizontal dos pontos selecionados.

Vertical Alignment: Cria o alinhamento vertical dos pontos selecionados.

Superelevations: Caso essa opção seja marcada, o programa criará um alinhamento
paralelo  buscando  os  pontos  em  que  a  coordenada  X  deslocada  do  ponto  de  medição
selecionado e o mais alto do intervalo selecionado. Essa opção é muito comum para a criação
de alinhamentos de trilhos.

10.10 Filtro das Seções Transversais

Ao visualizar uma seção transversal individualmente pode-se verificar se existem erros
causados por pontos que deveriam ter sido filtrados. Em vez de ir até a nuvem de pontos onde
a seção transversal está localizada, eliminar os pontos e calcular as seções novamente, pode-se
acessar os filtros de seleção usando a barra de ferramentas correspondente. A diferença é que
a seção transversal será recalculada automaticamente pela eliminação ou inclusão de pontos.

Na  figura  abaixo  é  possível  visualizar  uma  seção  transversal  errada  porque  foram
usados no cálculo, pontos que deveriam ter sido eliminados no filtro.
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Clique em  Select na janela  Cross Sections > Filter, e desenhe a caixa de seleção nos
pontos que danificam a seção transversal.

A amostra de pontos é marcada.
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Clique em Delete e os pontos marcados são filtrados pela seleção. A seção transversal
será automaticamente recalculada. Como pode-se visualizar na imagem abaixo, agora a seção
transversal está correta.
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10.11 Importando Seções Transversais

Para  importar  arquivos  de  seções  transversais  no  formato MDT  (*.TRA),  deve-se
fornecer antes os arquivos de alinhamentos horizontal e vertical, pois o programa precisa da
posição e orientação de cada seção transversal para exibi-las em 3D.

10.12 Exportando Seções Transversais

Pode-se  exportar  as  seções  transversais  em 2D no formato  MDT (*TRA),  ou como
arquivo de pontos com as coordenadas 3D de cada vértice.

Esse comando exporta as seções transversais  como arquivos de seções compatíveis
com  MDT (*TRA).  Primeiro, define-se o intervalo de estacas para que se possa exportar as
seções transversais correspondentes ao intervalo.

Acesse a ferramenta pelo menu Cross Sections > Export Cross Sections.

[TcoScancyr Advanced] Existem dois tipos de exportação de vértices 3D de uma seção
transversal. Caso a opção All seja marcada, o programa exportará todos os pontos contidos na
polilinha. Caso marcada a opção Number of points, é possível escolher o número de pontos
que se deseja exportar. Esses pontos serão calculados com a interseção das seções transversais
e linhas radiais ao centro.

10.13 Exportando Perfis

Dos arquivos de seções transversais é possível gerar perfis compatíveis com MDT 
(*.LON).

Selecione o intervalo de estacas e então defina se existem limites superiores e 
inferiores para cada perfil ou dimensão para o offset escolhido.

Então selecione os arquivos de saída para gravar os dados. Não é necessário especificar
os dois arquivos, apenas um deles já é o suficiente.
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10.14 Exportando Seções Transversais para DXF

Esse  comando exporta  o  arquivo  de  seções  transversais  para  o  formato  DXF.  Para
configurar a exportação, é necessário utilizar a caixa de diálogo a seguir:

• Dimensions: as  seções  transversais  podem  ser  exportadas  em  2D  ou  3D.  Em  3D
algumas opções não estarão disponíveis.

• Export:  nessa  opção  é  possível  indicar  os  elementos  que  irão  compor  a  seção
transversal  que se  deseja exportar.  Todas definidas serão sempre exportadas.  Cada
elemento a  ser  exportado (cotas,  superfícies,  pontos  de controle)  tem o  nome da
camada desejada como um prefixo no nome.
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Points: Exporta os pontos que compõem a seção transversal, a espessura é a mesma
que em Cross Section > View > Points Cloud.

Template: Exporta a seção-tipo aplicada na seção transversal.

[TcpScancyr Advanced] 3D Alignment: Exporta o alinhamento 3D.

Surfaces:  Inclui  todas  as  polilinhas  que  definem  as  superfícies  de  overbreak  e
underbreak.

Dimensions: Inclui a camada com as dimensões da seção-tipo à seção transversal.

Control Points: Inclui a camada que definem os pontos de controle.

Text  Height:  Altera  o  tamanho  do  texto  que  mostra  as  informações  das  seções
transversais.

• Cross Sections: Pode-se exportar uma seção transversal única, indicando essa estaca,
ou um intervalo indicando a estaca inicial e a final. Pode-se também estipular suas
cores.
Caso tenha sido calculada uma seção transversal de um ponto simples ou manual, essa

seção será marcada para exportação separadamente.

• Format:  Pode-se especificar o formato de saída das seções transversais, contínuo ou
modo  folha.  Também é  possível  alterar  a  escala  para  ajustar  o  desenho ao  papel
usando o controle correspondente. 

Ao mudar os valores, a linha aparecerá exibindo as informações assim como as seções
cortadas para aquela folha.

• Information: Pode-se indicar os dados que se deseja exibir para cada seção transversal,
assim como controlar sua posição com relação ao desenho usando os ícones esquerda,
direita, acima e abaixo. 

Station: Estaca da seção

Azimuth: Orientação do alinhamento na estaca na qual a seção foi calculada.

Slope: Inclinação do alinhamento vertical na posição da seção transversal.

Coordinates: Coordenada X e Y do alinhamento.

Gradient Spot Height: Cota do alinhamento vertical na estaca.

Superelevations: Valores da superelevação à esquerda e à direita da estaca.

Surfaces: Valores da superfície de underbreak e overbreak para cada camada de seção-
tipo.
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Output  file:  Cria  ou  seleciona  um  arquivo  DXF  onde  as  seções  transversais  serão
desenhadas. Caso o arquivo de saída não seja especificado, o ícone Accept ficará desabilitado.

É importante que o arquivo selecionado não esteja sendo usado por outra aplicação.

10.15 [TcpScancyr Advanced] Exportando Pontos Interiores

Exporta os pontos da seção transversal que estão dentro da seção-tipo.

11 Seção-Tipo

Para calcular superfícies e volumes de escavação é necessário definir, ao menos, uma
seção-tipo. O software não limita o número máximo de seções-tipo, porém em cada estaca é
permitido que apenas uma seção-tipo seja aplicada.

Cada seção-tipo contém indeterminado número de camadas, e isso define a polilinha
que defina a seção-tipo.

Abaixo da barra de ferramentas, a janela é dividida em duas partes. À esquerda está
localizada a árvore do projeto e as camadas criadas para o túnel. À direita pode-se visualizar o
editor usado para alterar as seções.

Na parte inferior, existe uma barra de ferramentas com as coordenadas e informações
do estado atual.

O menu de edição de características com comandos de desfazer e refazer,  também
possui comandos para colar e cortar. Funcionam da mesma forma que em outras aplicações.
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Pode-se criar quantas seções forem necessárias, embora elas não possam se sobrepor.
Use o menu Section > New Section para criar a nova seção, Section > Edit Section para editar
os parâmetros da seção ou apagar a seção que desejar em Section > Delete Section. 

Também  é  possível  utilizar  o  menu  de  contexto  que  aparece  quando  a  seção  é
selecionada na árvore do projeto.

A caixa de diálogo usada para criar ou editar a seção é como mostrado abaixo:

Name: Nome da seção-tipo. Duas seções não podem ter o mesmo nome.

Station  Range:  Valores  mínimo  e  máximo  das  estacas  onde  o  valor  será  aplicado.
Valores mínimo e máximo para o alinhamento horizontal do projeto ser exibido. Esses valores
não podem sobrepor seções já criadas.

Horizontal  Alignment  Position:  Coordenadas  onde  os  alinhamentos  horizontal  e
vertical  passarão.  Com esse ponto, pode-se dispensar a posição da seção com relação aos
alinhamentos.
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Superelevation  Positions:  Ponto  de  aplicação  das  superelevações.  Este  ponto  de
aplicação é supostamente a posição da seção com relação à origem dos eixos (0,0).

Destroy Height: Indica  se há ou não,  uma altura de destruição e sua posição com
relação ao grade.

Caso  queira  deslocar  todas as  camadas  e  pontos  de  controle  criados,  use  o  menu
Section > Move Section. Será exibida uma caixa de diálogo onde pode-se localizar os offsets
horizontal e vertical a serem aplicados.

Valores positivos movem as camadas e os pontos para a direita e para cima, enquanto
que valores negativos movem na direção oposta. Caso deseje deslocar os pontos de controle,
deve-se marcar a caixa correspondente.

11.1 Camadas das Seções

Pode-se definir um número variado de camadas a cada seção. Use o menu Layers, ou o
menu de contexto para selecionar a camada na árvore do projeto para acessar as opções a
seguir.

New Layer: Cria uma nova camada na seção atual, também cria uma nova aba onde a
camada pode ser desenhada. Uma caixa de diálogo será exibida permitindo inserir o nome da
camada.

Edit Name: Edita o nome da camada atual.

Edit Layer: Abre uma nova aba, permitindo a edição da camada.

Delete layer: Apaga a camada atual. Caso a aba esteja aberta, a mesma será fechada.

11.2 Importando Seções-Tipo

Seções-tipo  podem  ser  importadas  do  TcpTunnel  (*.TNL)  e  de  arquivos  DXF.
Recomenda-se que o arquivo DXF não seja muito complexo, se possível contendo apenas a
seção-tipo já que o programa pode não reconhecer algumas entidades do arquivo DXF.

Importada a seção-tipo,  surgirá uma aba com o nome do arquivo.  Pode-se usar os
comandos cortar e colar para associá-la a uma camada específica, No caso da importação de
arquivo TcpTunnel, como pode conter mais de uma seção, o programa abrirá uma aba para
cada seção.

Para transformar o desenho importado em uma camada, deve-se utilizar os comandos
de cortar e colar.
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[TcpScancyr Advanced]  Também é possível importar seções transversais do formato
MDT (*.TRA).  Essa  opção pode ser  acessada através  do menu  Tunnel,  na  janela  principal.
Quando  selecionado  Tunnel  >  Import  Templates o  programa  perguntará  pelo  arquivo  de
seções-tipo,  o  arquivo  do  alinhamento  vertical  e  poderá  ser  escolhido  entre  seções-tipo
abertas ou fechadas.

11.3 Elementos das Seções

Caso deseje aplicar superelevações à seção-tipo, deve-se marcar as diferentes partes
da seção, para que o programa possa entender como modificar a seção. Pode-se alterar o tipo
de cada parte na tabela que define a seção-tipo ou usar o ícone correspondente na barra de
ferramentas.

Superelevations: Parte  da  seção-tipo  que  é  modificada  com  a  aplicação  de
superelevações.

Fixed:  Parte da seção-tipo que não é modificada, mas é movia para coincidir com as
partes das seções que estão conectadas.
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Variable: Parte da seção que é alongada ou encurtada para coincidir com a parte fixa
ou superelevações mais próximas ou partes subsequentes da seção. A seção-tipo dever ter
apenas uma ou duas partes variáveis.

No geral,  a parte mais baixa deve ser marcada como a cota superior, caso seja um
pavimento  deve  ser  fixo  e  as  seções  verticais  que  fazem  as  paredes  do  túnel  devem  ser
marcadas como variáveis. Exemplos:

11.4 Definição manual da seção

Também é possível definir a seção-tipo escrevendo suas coordenadas e o raio de cada
vértice. Para acessar a janela para inserir os valores numéricos, use o ícone Edição numérica da
seção.

A janela de inserção numérica é dividida em duas partes – na parte superior está a
barra de ferramentas que possui as mesmas funções como nas outras áreas do software.

Abaixo dos ícones está a tabela onde é permito inserir os dados. Se a linha possuir um
raio maior que zero, será formado um raio entre o ponto dessa linha e o ponto da linha abaixo.
Caso seja a última linha, ela será unida ao primeiro vértice. A última coluna mostra o tipo da
seção.

Todas as seções devem ter seus dados inseridos no sentido horário, e também devem
ser fechadas.  Isso significa que o programa sempre unirá o último ponto ao último, sendo
assim o último ponto não pode ser o mesmo que o primeiro.
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11.5 Critério de Raio

Dado dois pontos e um raio, tem-se quatro possíveis arcos. O programa determinará
qual arco deverá ser usado dependendo do grau e do sinal do raio.

Supondo que existe um lado AB e um raio R, das quatro soluções as que cobre mais de
180 graus podem ser  descartadas.  Dos dois  arcos restantes,  se  o  raio  é positivo,  o arco à
esquerda do segmento AB será usado. Se é negativo, o arco à direita é usado.
Outra forma de visualizar como o sinal do arco afeta o programa é que o valor positivo criou
arco em direção ao lado de fora da seção, no caso de valor negativo o arco criado é em direção
do lado de dentro.

11.6 Como criar uma seção de improviso

Caso  seja  aberta  uma  inserção  numérica  com  uma  camada  vazia,  ou  a  seção  for
apagada, a tabela surgirá vazia. O editor é usado como a seguir:

 Clique no ícone novamente e a linha aparecerá com todos os valores como 0.0 caso a
tabela esteja vazia. Caso tenha elemento, a linha será inserida abaixo do cursor, com os
mesmos dados da linha atual (onde o cursor está posicionado).

 Após definir o raio e clicando em Enter, uma nova linha será criada com o mesmo valor
que foi inserido, neste caso, como a linha final.

 Quando o raio é modificado em uma linha intermediária, o programa calculará se é
possível recalcular os limites do arco. Se não for possível, surgirá uma mensagem e o
valor será alterado para o valor mínimo do raio que une os dois pontos extremos do
arco.

 Quando sair da última linda, se foi criada automaticamente (pela definição do raio) ou
movendo o cursor da última linha, ela será automaticamente apagada caso não tenha
sido modificada.
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11.7 Pontos de controle

Para cada camada criado, pode-se definir uma série de pontos de controle que serão
usados para calcular os desvios dos alinhamentos e para calcular as distâncias desses pontos
para as seções transversais.

Dependendo  do  tipo  de  ponto,  ele  pode  ser  usado  para  calcular  o  alinhamento
horizontal,  o alinhamento vertical  ou ambos.  Mais  de um ponto de controle já  deve estar
definido ou então os cálculos não serão corretos.

Adiante será explicado como usar esses pontos para calcular o desvio do alinhamento.

Pode-se também gerar pontos de controle automaticamente usando o menu Layers >
Generate control points …

Para gerar os pontos de controle, deverão ser escolhido dois pontos fora da seção-tipo,
inicial e final. Os pontos de controle serão gerados com a separação definida.
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11.8 Associando Seções-Tipo

Uma vez que as seções-tipo são criadas, deve-se definir qual se deseja usar em um ou
mais intervalo de estacas.

Pode-se associar a mesma seção-tipo para diferentes intervalos e deixar seções-tipo
sem nenhum intervalo associado.

12. Rota do Túnel

Deve-se definir a rota do túnel seguindo o alinhamento. Também é possível exportar a
rota em um arquivo AVI.

A rota do túnel é carregada através da nuvem de pontos, da estaca mínima para a
estaca máxima, mesmo se existiram áreas sem o cálculo das seções transversais, ou seções sem
pontos.

A parte mais abaixo da janela é dividida em três painéis, descritos a seguir:

 Options

Deve-se definir as opções de visualização – esses valores podem ser alterados quando
se está no modo avançado.

Observer Height: a altura do observador com relação ao alinhamento vertical.

Light by distance: se habilitado, os pontos mais distantes aparecerão mais escuros,
dependendo da distândia máxima de visão.

Speed: a velocidade que a câmera avança pela rota clicando nos ícones de avanço ou
retorceder no modo contínuo.

Maximum Distance: distância máxima de visão a partir da posição da câmera.

Initial and Final Station: intervalo de estacas usando o avanço automático.

 Route

Painel usado para mover a câmera sobre o alinhamento.
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Os ícones da esquerda para a direita são:

First: move a câmera para a primeira estaca da nuvem de pontos.

Previous: move a câmera para trás, seguindo o alinhamento.

Return: retorna  a  câmera  em modo contínuo,  moverá  seguindo o  alinhamento  na
velocidade indicada no controle correspondente.

Stop: interrompe a câmera do modo de avanço contínuo ou modo de retorno.

Advance: avança a câmera no modo contínuo, se moverá seguindo o alinhamento na
elocidade indicada no controle correspondente.

Next: move a câmera à frente, seguindo o alinhamento.

Last: move a câmera para a estaca final da nuvem de pontos.

Station: estaca onde a câmera está posicionada. Pode-se inserir o valor manualmente
ou usando a barra de rolagem.
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 View

Esse painel  permite exibir  ou ocultar camadas diferentes que serão combinadas na
cena. As camadas disponíveis dependem dos dados que foram calculados.

 Export to AVI

Pode-se usar a opção do menu File > Export para criar o arquivo AVI com a rota. A rota
será criada com a velocidade atual, iluminação e camadas ativas.

A  qualidade  do  vídeo  criado  dependerá  do  formato  de  saída  usado  e  dos  dados
exibidos.

O formato de saída dependerá dos codecs instalados no computador, deve-se conhecer
quais codecs devem ser instalados no computador para reproduzir o vídeo, mas não para criá-
lo.

13. Relatório de Área e Volume

Uma vez  que  as  seções  estão  calculadas  e  as  seções-tipo estão  definidas,  deve-se
calcular  a  lista  de  volumes  permitindo  a  visualização  dos  volumes  de  escavação.  Essa
ferramente pode ser acessada no menu Tools > Area Reports. 

Nos dados gerais das seções, deve-se escolher o arquivo de seções a ser usado, assim
como o intervalos de estacas. Caso seja escolhida a opção Only Terrain o relatório de volumes
será calculado sem a comparação com qualquer outra seção-tipo.

Selecionando  as  opções  Top  Heading e  Bench,  colunas  serão  adicionadas  com  as
seções-tipo cortadas na cota associada.
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13.1 Comparação de Seções Transversais

Pode-se comparar dois arquivos de seções. Ambos arquivos devem estar incluídos no
projeto.

A caixa de diálogo abaixo aparecerá:

Será  necessário  especificar  dois  arquivos  de  seções,  o  intervalo  de  estacas  será
aplicado do primeiro arquivo de seções.  Pode-se definir  uma cota de marcação e  o  offset
(positivo para fora, negativo para dentro) para o segundo arquivo de seções.

Clicando em Preview, a caixa de diálogo Export Cross Sections será exibida, permitindo
que sejam configurados os campos que se deseja exportar. Aceitando a caixa de diálogo será
criada uma prévia da comparação das seções transversais. 

Aceitando a caixa de diálogo será exibido o relatório da superfície e do volume das
diferenças entre as seções transversais A e B.
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14. Relatório de Desvio do Alinhamento

Caso  já  tenha  definido  as  seções  transversais  e  as  seções-tipo,  pode-se  calcular  a
posição do alinhamento, baseado nas seções transversais. Selecionada essa opção, surgirá uma
caixa de diálogo permitindo selecionar o método a ser usado e a camada de cada seção do
alinhamento definido.

Após calculado o desvio, ele é representado no alinhamento horizontal e vertical.
Selecione o método e os parâmetros a serem usados. Por baixo, selecione a camada a

ser usada para os cálculos. Após definir tudo, clique no botão Calculate para calcular o desvio.

Uma vez calculada, o lado direito da caixa de diálogo exibirá a lista com os pontos
através  do  alinhamento  para  cada  estaca  onde  houve  cálculo  das  seções  transversais.  As
colunas são descritas a seguir:

Station: estação na qual  é retirada uma amostra – coincide com a estaca onde foi
calculada a seção transversal.

Real X, Real Y, Real Z: coordenada absoluta para o alinhamento calculado.

Hor.  Diff: offset  horizontal  do  alinhamento  em  relação  ao  alinhamento  horizontal
teórico.

Ver. Diff.: offset vertical do alinhamento em relação ao alinhamento vertical teórico.
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Na parte inferior pode-se selecionar um arquivo de saída afim de criar um alinhamento
horizontal incluindo detalhes de offset.

As três maneiras para calcular offset dos alinhamentos são descritos a seguir:

14.1 Cálculo baseado nos pontos das seções transversais

Esse método somente se aplica se houver seção circular. A seguir o método de cálculo:

1. Identificar os pontos que estão mais altos, mais à esquerda e mais à direita para cada
seção transversal.

2. Usando esses três pontos, o círculo que passa através deles podem ser calculados.

3. O deslocamento do centro do círculo e o centro da seção pode ser calculado.

14.2 Cálculo baseado em pontos de controles

Primeiro, esse método calcula o retângulo mínimo que engloba todos os pontos da
seção transversal. Com esse retângulo o programa define a melhor posição para pontos de
controle, tentando minimizar os seguintes valores:

1.  A  distância  de  cada  ponto  para  a  seção  transversal.  Permite  que  a  seção  seja
posicionada tão fechada quanto para possibilitar a seção transversal.

2. A variação da distância dos pontos. Isso não é suficiente para dizer que os pontos são
fechados para a seção transversal; a distância também deveria ser tão similar quanto possível
em todos os pontos de controle.

Se realizada a compensação para a posição dos pontos de controle, pode-se fazer o
alinhamento desaparecer como os pontos “puxados” em uma direção. Na imagem a seguir
tem-se o offset do alinhamento calculado com três pontos de controle (marcados com um x).

A seção transversal pode ser visualizada em vermelho, a posição da seção-tipo fora do
alinhamento  em branco,  e  em verde  a  posição calculada  da  seção-tipo usando pontos  de
controle.

Surgirá deslocado para cima, porque se estiver abaixo do eixo, os pontos nos lados
terão  uma  evolução  pior  (eles  estarão  distanciados  da  seção  transversal)  porque  a  seção
transversal é alargada.
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Adicionando um quarto ponto, pode-se fazer o ponto “afastar” o deslocamento da
posição calculada.

14.3 Cálculo usando a seção-tipo

O  método  é  baseado  em  dividir  a  seção-tipo  em  um  número  “X”  de  partes  e
internamente  criando  um  número  “X”  de  pontos  de  controle.  Esses  pontos  criados  são
passados em um algoritmo a fim de calcular o desvio do alinhamento.

Pode-se usar o controle Divisions para criar mais ou menos pontos ao logo da seção-
tipo – quanto maior o número de divisões, melhor o resultado.
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15. Relatório de Pontos da Seção Transversal

Usando o comando  Tools > Cross Sections Points Report pode-se criar listas onde é
possível visualizar a distância de cada seção transversal para o ponto da seção-tipo.

16. Relatório de Pontos de Controle

Usando o menu  Tools > Control  Points Report pode-se criar listas  onde é possível
visualizar a distância de cada ponto de controle para a seção-tipo.

O programa calculará a projeção do ponto de controle na seção-tipo, e usará a linha
direta para calcular a distância para a seção transversal.

Usando  o  menu  de  contexto  é  possível  acessar  a  representação  gráfica  da  seção
transversal.

17. Relatório Gauge

Usando a seção transversal e a seção-tipo será possível calcular o relatório gauge. Ele
consiste do cálculo para confirmar ou não se cada seção transversal está dentro da seção-tipo.

Para cada seção transversal em que não é possível passar o controle de gauge, ela será
adicionada a lista que aparece abaixo da lista de seções transversais na janela do projeto. Essa
lista não é salva com o projeto.

18. Relatório Bolts

Este relatório permite visualizar área que restam para ser escavada e pode exportar o
dado calculado como pontos 3D para locação (estaca, offset e cota).

O parâmetro para definir é o intervalo das estacas.  A cota mínima com relação ao
alinhamento vertical fora de onde analisamos a seção transversal para encontrar áreas que
precisam ser escavadas.
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A espessura mínima controla o valor para a área a ser escavada. Caso exista um vértice
com uma área mais espessa a que pertence será incluída no relatório.

Com o parâmetro de controle do vértice foi gerado com cada área a ser escavada.
Os relatórios mostram os parafusos com a posição de acordo com o desenvolvimento

da seção teórica. Para exportar os dados, usa-se o botão Export bolts.
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19. Corte circular

No caso de um túnel circular é possível gerar um relatório ajustando um círculo em
cada seção transversal, gravando para cada uma o deslocamento na horizontal e na vertical, e
também o raio.

O  parâmetro  da  cota  mínima  é  usado  para  cortar  a  seção  transversal  e  assim,
desconsiderar a parte inferior. Usando esse corta na seção transversal, o programa busca nas
laterais e no topo para calcular o círculo passando através desses três pontos.
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20. Mapa de inspeção

Nesse  comando  pode-se  exportar  uma  imagem  com  a  representação  do  túnel
projetado na seção teórica. 

A imagem gerada é o resultado da tomada de cada ponto, medindo a distância a partir
da seção teórica e seu desenvolvimento, aplicando cor e coordenada Y respectivamente. Na
imagem resultante, os pontos seguem o alinhamento correspondente para os pontos à direita
dele (deslocamento positivo).

 
Os parâmetros a serem configurados são o intervalo de estacas, e os valores mínimos e

máximos  para  colorir.  Eles  representam  a  distância  para  a  seção  teórica  e  o  tamanho da
imagem exportada.

Ao usar o botão Apply, o programa mostrará a imagem resultante sem fechar a janela
Inspection map.

É possível escolher um intervalo de cores diferente para valores positivos e para valores
negativos, editar o intervalo de cores e o valor dos intervalos.
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A imagem resultante sempre será um pouco maior para desenhar a escala de cores em
cada lado.
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21. Ortoimagem

Como o comando mapa de inspeção, mas usa as cores reais ou a intensidade de cada
ponto.

22. [TcpScancyr Advanced] Importar DXF

Permite a importação de um DXF e exibe na nuvem de pontos.

23. [TcpScancyr Advanced] Desenhar Polilinha 3D

Permite desenhar polilinhas 3D fora da nuvem de pontos. Para desenhar polilinhas,
primeiro é preciso criar uma nova camada e selecioná-la como atual. Então, pode-se usar a
opção Draw polyline da barra de ferramentas.

As camadas e suas polilinhas serão gravadas em um arquivo DXF anexado ao projeto
com o nome <project>_user.dxf, na mesma pasta do projeto.

24. Editor de Seção Transversal

O programa inclui um editor de seção transversal que pode ser usado para modificar
qualquer seção transversal  do projeto.  Caso uma seção-tipo tenha sido definida,  a  mesma
aparecerá  com a  seção transversal  a  ser  editada.  Entretanto,  a  seção-tipo não podem ser
alteradas, serão somente mostradas como ponto de referência.

A parte central do editor possui uma aba no topo que indica a seção transversal a ser
editada. Caso tenha um asterisco no final, a seção foi modificada desde a última vez que foi
gravada.

A  seguir  o  modo  operacional  do  editor  é  exibido.  É  comum  ao  editor  de  seção
transversal e ao editor de seção-tipo. Deve-se ficar atento à barra de status, que mostrará a
informação do estado atual.

 Ao clicar na seção transversal, ela será marcada como selecionada. Será mostrada a
posição de cada vértice como um quadrado verde.
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 Ao clicar em um vértice ou em um lado, pode-se mover no estado Modify. Agora pode-
se usar o cursor para modificar o elemento para a posição desejada. Ao dar um duplo
clique com o botão esquerdo, pode-se interromper a seleção e retornar para o estado
de Seleção.

 A tecla Esc permitirá sair do estado atual.
 Quando  se  está  no  estado  Seleção  e  uma  está  selecionada,  a  seleção  da  seção

transversal será cancelada.
 Quando se está modificando a figura, a  modificação será cancelada e retornará ao

estado de Seleção.

Ao fechar o editor, surgirá a pergunta se deseja-se salvar todas as modificações que
foram realizadas na seção transversal.

25. Barra de Ferramentas

Para acessar as várias opções da aplicação, use as barras de ferramentas abaixo.
As aplicações da barra de ferramentas são descritas a seguir:

25.1 File

Para acessar a barra de ferramentas mais comuns do menu de arquivo, existe uma
barra de ferramentas na janela principal.
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Os ícones da esquerda para a direita são:

New Project: abre uma caixa de diálogo para criar um novo projeto.

Open Project: abre o seletor de arquivos para carregar um arquivo existente.

Project Properties: abre uma caixa de diálogo para alterar certas áreas do projeto.

Save Project: salva o projeto atual sem perguntar ao usuário pelo nome do projeto.
Para essa opção ser habilitada, o projeto já deve estar alocado no computador.

25.2 View

Permite alterar a vista do projeto e a vista do desenho. Caso esteja sendo visualizado
em 2D, essas opções estarão desabilitadas:

Os ícones da esquerda para a direita são:

Projection  Type: essa  opção  estará  habilitada  no  caso  de  desenhos  3D.  Quando
habilitada, projeção ortográfica será aplicada. Com essa projeção, o tamanho dos objetos não
serão baseados na distância da câmera. Se a opção está desabilitada, a projeção de perspectiva
será aplicada. Neste caso, o tamanho do objeto dependerá da sua distância para a câmera.

Front View: pontos da câmera em direção ao eixo Y.

Top View: pontos da câmera em direção ao eixo Z.

Side View: pontos da câmera em direção ao eixo X.

Rotation Center: seleciona o ponto dentro da área do desenho (que deve ser somente
desenhado) para alterar o ponto de rotação.

25.3 Drawing

Com essa barra de ferramentas pode-se controlar a posição e a ampliação do desenho.
Se a projeção de perspectiva está habilitado, a aproximação do zoom, o afastamento

do zoom, ampliação da extensão e ampliação dos ícones da janela serão desabilitadas.
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Os ícones da esquerda para a direita são:

Zoom in: zoom de fora do desenho para o centro. Pode-se também usar a roda do
mouse movendo-a para frente, mas nesse caso o ponto de zoom será a posição do mouse.

Zoom out: zoom para fora do desenho a partir do centro. Pode-se também usar a roda
do mouse movendo-a para trás, mas nesse caso o ponto de zoom será a posição do mouse.

Zoom Extension: a vista é ampliada ou reduzida a fim de visualizar todos os itens do
desenho, enquadrando somente as camadas visíveis.

Zoom Window: aplica zoom em uma área do desenho, o primeiro clique do mouse
marca um canto da janela, e o segundo marca o canto oposto.

Pan: o desenho pode ser movido através do clique na janela e movendo o mouse sem
tirar o curso de dentro da janela.

25.4 Layers

Pode-se ocultar ou exibir as camadas que compõem o desenho. Por isso é necessário
abrir o Layer Control e selecionar o ícone lâmpada. O nome da camada não pode ser alterado.

[TcpScancyr Basic] Clicando no ícone Set Up pode-se alterar a cor de fundo, os eixos de
referência, o zoom e as janelas de seleção.
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[TcpScancyr Advanced] Pressionando o botão de configuração pode-se ver a lista das
camadas  organizadas  por  grupos.  A  caixa  de  diálogo  também  permite  ocultar  grupos  de
camadas,  remover  camadas  dos  grupos  “Dxf”  e  “User”,  assim  como  também  criar  novas
camadas no grupo.
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25.5 Grid

Inclui  botões  para  habilitar  ou  desabilitar  as  referências  no  desenho  visualizado
atualmente. Eles somente serão habilitados quando estiver desenhando em 2D.

Os ícones da esquerda para a direita são:

Axes: desenha os eixos XY no desenho se estiverem disponíveis.

Grid: habilita ou desabilita a vista do grid no desenho.

Grid Properties: exibe a caixa  de diálogo permitindo que os valores do grid  sejam
alterados.

25.6 Referência para Figuras

Referências  para  objetos  permitem  que  seja  rapidamente  selecionado  pontos
geométricos  nas  figuras  existentes  sem  precisar  conhecer  as  coordenadas  exatas  desses
pontos. Referência para objetos podem ser usadas para selecionar o ponto final da linha ou do
arco, o ponto médio de um círculo, ou qualquer outra posição geometricamente significante.

Quando mais de uma referência está aitvada, a mais próxima de todas as habilitadas
serão exibidas.

 
Os ícones da esquerda para a direita são:

Point: marca o ponto como referência.

Close: marca  o  ponto  mais  próximo da  posição  do  cursor,  aplicável  para  qualquer
figura, exceto pontos.

End Point: marca  o  lado da figura,  ou uma das  partes  que estão mais  próximas à
posição do mouse. Não se aplica a círculos.

Midpoint: marca o ponto médio da figura.

Centre: marco o centro da figura mais próxima do mouse.

Quadrant: marca as quatro extremidades da circunferência.
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25.7 Seleção de Pontos

Quando visualizados a nuvem de pontos ou as seções transversais pode-se selecionar
os pontos como filtrados ou remover essa marca.

Selecionado os pontos, os mesmos aparecerão marcados. Ao clicar com o botão da
direita  do  mouse,  abrirá  um  menu  de  contexto,  permitindo  filtrar  os  pontos  (Eliminate
Selection), ou remover a marca de filtro (Include Selection).

No caso de ser selecionado por polilinha, deve-se usar a opção Select para finalizar a
polilinha e selecionar os pontos que ali estão.

Os ícones da esquerda para a direita são:

Remove: remove os pontos com a marca de seleção.

Window: seleciona os pontos via janela retangular.

Circle: seleciona os pontos via janela circular, primeiro marcando o centro do círculo, e
depois, movendo o mouse para definir o raio.

Polyline: seleciona os pontos via polilinha. Clicando com o botão esquerdo do mouse
pode-se adicionar vértices, para finalizar a polilinha, abra o menu de contexto com o botão
direito do mouse e selecione a opção correspondente.

25.8 Escala

Dependendo do desenho visualizado, pode-se habilitar a mudança do fator da escala
vertical.

Os valores aplicáveis vão de x1 (escala normal) até x10, caso seja necessário um valor
maior, o mesmo deve ser escrito no Controle.

25.9 Help
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Os ícones da esquerda para a direita são:

Measure distances: Esse comando permite medir distâncias entre dois pontos, 
primeiro selecionando o ponto inicial de medida, e então o ponto final. A distância medida será
exibida na barra de status. É recomendável ativar as referências necessárias na figura, ou então
a aplicação pode retornar dados incorretos caso as coordenadas usadas não sejam as do ponto 
que realmente se deseja medir. 

Após o segundo ponto ser selecionado, surgirá a janela a seguir:

Os valores do ponto inicial e final na linha XY, XYZ representam a distância do ponto 
origem para o ponto no plano XY ou XYZ ,respectivamente.

 Number Edit: exibe a janela a seguir, onde as coordenadas podem ser inseridas 
manualmente. No caso de desenhos 2D, o controle da coordenada Z estará desabilitado.

Após inserida as coordenadas, pressione OK. No modo de coordenadas absolutas, as 
coordenadas inseridas serão adicionadas. No modo de coordenadas relativas, as coordenadas 
inseridas serão consideradas incrementos do último ponto inserido.

25.10 Points

Altera o tamanho dos pontos, o valor é o mesmo para todos os pontos.



67

25.11 Modify

Comandos que permitem modificar as polilinhas.

Insert vertex: insere um vértice no ponto selecionado. Ele deve estar próximo a um
lado.

Eliminate vertex: elimina o vértice selecionado. Recomenda-se selecionar a polilinha
para visualizar onde estão os vértices.

Eliminate range of vertex: marca dois vértices, onde todos os vértices entre eles são
apagados.

Eliminate vertices window: marca um retângulo com o mouse e os vértices que se
encontram dento do retângulo são apagados.

Join Polylines: esse comando permite unir duas polilinhas. Primeiro é preciso desenhar
uma polilinha que intercepta a seção transversal em dois pontos. Pode-se usar essa ferramenta
para selecionar a seção transversal e então a polilinha que foi criada.
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Desenhe uma polilinha que intercepta a seção transversal. Para vértices intermediários
pode-se usar a ferramenta de referência para assegurar que os mesmos vértices são usados
como para a seção transversal original, porém com a ordem correta.

Usando a ferramenta Join, selecione primeiro a seção transversal e depois a polilinha.
O programa juntará automaticamente as duas polilinhas.



69

25.12 Shapes

Usando essa barra de ferramentas pode-se criar figuras para adicionar ao desenho. Da
esquerda para a direita estão linhas, polilinhas e círculos.

Atualmente é possível criar apenas polilinhas para uni-las com as seções transversais e
então corrigir os erros de angulo-ordenação.

Nas versões futuras haverão novas adições para essa ferramenta que deverá ser usadas
para criar seções-tipo graficamente. 

25.13 Move

Comandos usados para mover figuras.

Da esquerda para a direita, são descritas a seguir:

Move figure: primeiro selecione a figura para mover, então selecione os pontos como a
origem, e selecione o ponto de destino. A figura moverá pelo vetor origem - destino.

Move figure to the origin: primeiro selecione a figura, então defina o ponto de origem.
A figura moverá pelo vetor coordenada origem – ponto de origem.
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Copy with reference point: as funções desse comando como a anterior (Move figure
to the origin), porém a figura será copiado. Então vá até a camada que será modificada e cole a
figura usando Ctrl+V.

25.14 Barra de ferramentas Utility

Para  tornar  a  aplicação  mais  confortável,  essa  é  a  barra  de  ferramenta  onde  são
exibidas as opções mais usadas. Essa barra será a única disponível caso esteja sendo utilizada a
nuvem de pontos.

Da esquerda para a direita têm-se, informações, janelas auxiliares,  filtros,  símbolos,
intervalo de cores.

Use o ícone Informações para  consultar  detalhes  de qualquer  ponto da nuvem de
pontos. Na janela de informações do ponto selecionado, dependendo dos dados disponíveis
(alinhamento, cota), alguns campos estarão desabilitados.

O controle  Color Range é usado para alterar as cores aplicadas a um símbolo sem a
necessidade de recalculo.

Caso alguma janela flutuante tenha sido fechada (exceto filtros), é possível buscá-la
novamente clicando em Auxiliary Windows.

26. Tabela de Dados

Pode-se ver um número de elementos que surgirão em diferentes áreas do programa.
Essa função da mesma forma, adapta a aplicação para o dado em questão.

Em várias partes do programa pode-se ver a aba com uma série de ícones. No geral o
tipo  do  dado  exibido  variará  (alinhamento  horizontal,  lista  de  volume),  dessa  forma  suas
funções farão o mesmo.

Dependendo  dos  dados  associados,  algumas  das  opções  podem  ser  ocultadas  ou
desabilitadas.
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A ação que corresponde a cada ícone está a seguir, da esquerda para a direita:

Open: abre  o  arquivo  para  que  o  dado  seja  alterado.  Caso  esteja  em  Horizontal
Alignment pode-se abrir um alinhamento.

Save: grava os dados em arquivo. O formato dependerá da tabela de dados atual.

New: cria um novo arquivo. A caixa de diálogo surgirá permitindo que vários campos
sejam preenchidos.

Edit: edita a linha selecionada. A caixa de diálogo surgirá permitindo campos a serem
alterados.

Delete: apaga elementos da tabela selecionada.

Search: abre a caixa de diálogo permitindo a busca por um arquivo.

Quando se realiza a busca, o elemento correspondente será marcado, se não houver
elemento correspondente, o mais próximo será marcado.

Mais  de  um  parâmetro  pode  ser  especificado  em  cada  busca.  Por  exemplo,  caso
deseja-se buscar um alinhamento horizontal, escrevendo raio = 150, estaca 1000, a aplicação
buscará por uma curva ou um clotóide com raio próximo a 150 e estaca próxima de 1000.

Delete All: apaga todos os dados da tabela.

Export: exporta os dados para um número de formatos. Primeiramente uma caixa de
diálogo é exibida, permitindo a seleção dos dados a serem exportados e seus formatos.  A
ferramenta também permite apagar os campos a serem exportados sem alterar a ordem.

Dependendo da tabela a ser exportada, o grupo de colunas variará. Como exemplo, é
mostrada abaixo a lista para exportar um alinhamento horizontal.



72

27. Configuração

A seguir estão as diversas caixas de diálogo de Configuração.
Clicando em  Restore pode-se alterar os valores atuais  para os valores padrão.  Essa

mudança afetará somente a página selecionada.

27.1 [TcpScancyr Advanced] Drawing

Permite alterar as cores de fundo e dos eixos.

27.2 [TcpScancyr Advanced] Windows

Permite alterar a seleção, captura e zoom e cores da janela. 
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27.3 Horizontal Alignment

Permite alterar as cores e as distâncias para as marcas longas e curtas, assim como
alterar as cores de pontos únicos.

Short mark interval: distância em metros entre as marcas curtas. Ao lado existe um
ícone  para  associar  uma determinada  cor  à  marca.  O ícone  Options pode ser  usado para
configurar o formato das marcas.

Long mark interval: distância em metros entre as marcas longas. A cor e o formato da
marca também pode ser configurado.

Singular points: somente a cor e o formato dos pontos únicos podem ser configurados.

Line, Curve, Clothoide: a cor de cada tipo da seção do alinhamento.

Real Alignment: cor do alinhamento calculado com as seções transversais.

• Formato das marcas e dos pontos únicos.

Mark lenght: comprimento da marca. A linha será perpendicular ao alinhamento.

Extension lenght: caso existam textos no desenho, o valor marca a extensão da marca
ao lado do texto anexado.
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Align texts: textos podem ser alinhados à esquerda, à direita ou não alinhado. 

As  opções disponíveis  para  pontos  únicos  são os  mesmos para  as  marcas  curtas  e
longas. Pode-se também indicar se o texto é no lado interno ou externo.

27.4 Vertical Alignment

Permite que a aparência do alinhado vertical seja alterada.

As  cores  do  alinhamento  vertical  pode  ser  alterado,  como  a  cota  anterior,  linhas
verticais e texto.

Text Height: altura do texto em metros.

Short mark interval: distância em metros entre as marcas curtas.

Long mark interval: distância em metros entre as marcas longas.

Unique points: cor dos pontos únicos. São desenhados nos pontos descritos a seguir:

• Estaca – tangente
• Estaca + tangente
• Estaca se a tangente é igual a zero

Guitar: cor da separação de linhas e legendas.
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Gradient: cor e espessura em pixels do alinhamento horizontal.

Real gradient: cor do alinhamento calculado com seções transversais e seções-tipo.

Upper ground: cor da altura máxima entre a interseção da linha vertical  que passa
através do alinhamento e a seção transversal.

Lower ground: cor da altura mínima entre a interseção da linha vertical que passa
através do alinhamento e a seção transversal.

27.5 Superelevations

Permite definir a cor das superelevações à esquerda e à direita, e também o tamanho
do texto em pixels.

27.6 Cross Sections

Pode-se alterar a cor dos elementos que aparecem quando se estão visualizando as
seções transversais. Como pode-se ver, nenhum controle aparece para alterar a cor dos pontos,
eles aparecerão com a cor aplicada aos símbolos.
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